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ABOUT THIS MANUAL 
READ THIS OPERATING MANUAL BEFORE ATTEMPTING TO USE THE INSTRUMENT. 

 

This manual is valid for the PC850 (applies from serial number 24164 and Audibase version 5.5 onwards).  

This product is manufactured by:  
 Amplivox Ltd 

3800 Parkside, Solihull Parkway,  
Birmingham Business Park, Birmingham,  

West Midlands,  
B37 7YG  

www.amplivox.com 

For all enquiries please contact us under: 

Amplivox Ltd 
10393 West 70th Street 

Eden Prairie 
MN 55344 

United States 
 

Tel: 888 941 4208 
Fax: 952 903 4100 
info@amplivox.us 

Amplivox Ltd 
3800 Parkside, Solihull Parkway,  

Birmingham Business Park, Birmingham,  
West Midlands,  

B37 7YG 
United Kingdom  

Tel: +44 (0)1865 880846 
 

hello@amplivox.com 
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1. INTRODUCTION 

1.1. THANK YOU 

Thank you for purchasing the Amplivox PC850 audiometer, an air-conduction screening audiometer that is designed for 

use by audiologists and occupational health practitioners. Its primary use is as an automatic audiometer (interfacing to 

and launched from the Amplivox Audibase PC software). However it may also be used as a “standalone” manual 

audiometer that can save the results of up to 12 tests. These tests may then be transferred to Audibase at a later stage. 

This operating manual applies to the PC850 in combination with Audibase Software Version 5.5. Audibase allows 

electronic storage of audiometric test records on a PC, application of audiogram categorisation schemes, printing of 

audiograms and data exchange with other PC applications. 

The audiometer is not intended for use to determine the full extent and scope of a patient’s hearing deficiency. 

 

1.2. INTENDED APPLICATIONS 

This instrument is designed for use by trained personnel only, such as audiologists, ENT surgeons, doctors, general 

practitioners, hearing aid dispensers, child health professionals and hearing healthcare professionals with a similar level 

of education. It is not recommended to utilize the equipment without the necessary knowledge and training.  

The target patient population is suitable for patient over the age of 4.  

 

1.3. CONTRADICTIONS 

Always visually inspect the outer ear and the external auditory canal for abnormalities before testing. Testing should 

not be performed on patients in the following items is applicable.  

1. The presence of other sensitivity to loud sounds may contraindicate testing when high intensity stimuli are 
used. 

2. Recent outer ear surgery. 

 

1.4. STANDARD AND OPTIONAL COMPONENTS 

Shipping documentation will reference the stock number quoted above, and images of the parts alongside the relevant 

stock number are available on the Amplivox website (www.amplivox.com). The required fitting instructions are supplied 

with each part. 

STANDARD COMPONENTS 

PC850 Audiometer 8510385 Patient Response Switch 8011155 

Audiometric headset & leads (DD45) 8509615 Approved mains adapter UES12LCP 8512734 

HBA audiometric headband 8010882 Cable USB A to USB B (2.0 m) 8011241 
USB stick with Software and Operating 
Manuals 

8510705 
and 
8510707 
(OSHA) 

Carrying case  8532675 

Calibration certificate    
 

http://www.amplivox.com/
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OPTIONAL COMPONENTS 

Audiogram Cards    
 

OTHER COMPONENTS TO REORDER 

Audiocups (noise reducing earphone enclosures) 8010855 Headband (standard headphone) 8010882 

Audiocup ear cushion 8010835 Earphone cushion 8010857 

Audiocup headband 8507381 Earphones DD45 * 8010876 

Audiocup headband cover 8010834 Headset lead 8010822 

Booth Leads 8510195   

Accessories marked * require calibration with the specific audiometer to be used. Do not attempt to use these 

accessories until the audiometer has been calibrated to match their characteristics. 

 

Shipping documentation will reference the stock number quoted above, and images of the parts alongside the 

relevant stock number are available on the Amplivox website (www.amplivox.com). The required fitting instructions 

are supplied with each part. 

 

1.5. WARNINGS 

Throughout this manual, the following meanings of warnings and cautions apply: 

 

The WARNING label identifies conditions or practices that may present danger to the 

patient and/or user.  

 

The CAUTION label identifies conditions or practices that could result in damage to the 

equipment. 

 
  

WARNING 

CAUTION 

http://www.amplivox.com/
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2. PRINCIPLES OF OPERATION 

2.1. OTOSCOPIC EXAMINATION 

A suitably-qualified health care professional should perform a thorough otoscopic examination to establish that the 

condition of the ear is suitable for the test options selected and that no contraindications are present. The latter would 

include obstruction of the external ear canal due to excessive wax and/or hairs, both of which would need to be 

removed. This is required to ensure that the probe tone delivered by the probe are able to reach the ear drum and are 

not reflected by cerumen or debris and thereby alter the test result. 

 

2.2. PRINCIPALS OF PURE TONE AUDIOMETRY 

Ideally, hearing tests are conducted in a soundproof room. The purpose of pure tone audiometry is to measure the 

patient’s hearing threshold which is then compared to the hearing threshold of an average normal hearing person. The 

examination starts with air conduction on the ear with better hearing, or if not specified differently, on the right ear. 

The BSA (British Society of Audiology) recommends starting the test at 1000 Hz to then next measure the higher 

frequencies. When done with the high frequencies 1000 Hz shall be retested and to then continue with the lower 

frequencies. When done with the air conduction, the bone conduction is being assessed. 

In cases of unsymmetrical hearing, it might be required to mask the air and bone conduction in order to prevent hearing 

the test tone on the opposite ear. This phenomenon is called ‘crossover’ and occurs more often while testing bone 

conduction then air conduction.  

2.3. AUDIOMETRY PREPARATION 

Refer to the various audiometric standards and other relevant publications for guidance on audiometric testing. 

 

Ambient Conditions 

Audiometric testing should always be performed in quiet conditions (e.g. a quiet room or an acoustic booth). The 

optional Audiocups can provide an additional level of isolation from ambient noise.  For further explanation on 

permissible ambient noise levels, please refer to the audiometry standard ISO 6189. 

 

Test System Arrangement 

The schematic diagram below shows a typical example of the use of audiometric test equipment. The audiometer is 

located on the desk of a seated operator as shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Operator 

 

PC850 

Audiometer 

 

Computer (e.g. Tablet/Laptop) 

Patient, wearing headset 

 
Headset lead 

Response switch & lead 
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The patient is seated in front of the desk facing away from the operator. The patient wears a headset (see below) and 

responds to test stimuli by use of a hand-held switch which is also connected to the instrument. 

 

Headset 

The headset must be fitted by a qualified person to ensure a proper seal and comfortable fit. The leads from the 

headset are connected to the instrument and the headset is then fitted to the patient. 

 

Patient Instructions 

The patient is given the following instructions: “Press and then release the response switch when a tone is heard”. 

• In the case of Manual or Computer testing – “As soon as you hear the tone, press and release the response 

switch” 

• In the case of Bekesy testing – “press and hold the response switch when a series of pulses are heard, and 

release when the pulses are no longer heard” 
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3. UNPACKING AND INSTALLATION 

3.1. GENERAL 

Please check the contents of the shipping carton against the delivery note to make sure that all items ordered have 

been included. If anything is missing, please contact the distributor who supplied the audiometer or Amplivox if 

purchased directly. 

Please retain the carton and packaging as the instrument will need calibrating on an annual basis and should be returned 

to Amplivox in its original shipping carton. 

 

 

For supply in US only: Federal Law restricts this device to sale by or on the order of a licensed medical professional. 

 

3.2. MARKINGS 

The following markings can be found: 

Symbol Explanation 

 

Type B applied parts. According to IEC 60601-1. 

Patient applied parts that are not conductive and can be immediately released from the patient. 

 

Refer to instruction manual. 

 

WEEE (EU-directive) 

This symbol indicates that when the end-user wishes to discard this product, it must be sent to 

separate collection facilities for recovery and recycling. Failing to do so may endanger the 

environment. 

 

The CE-mark indicates that Amplivox Ltd. meets the requirements of Annex II of the Medical 

Device Regulation. TÜV Product Service, Identification No. 0123, has approved the quality 

system. 

 

Serial number. 

 

Date of manufacture. 

 

Manufacturer. 

 

Keep dry. 

 

Transport and storage humidity range. 

CAUTION 
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Transport and storage temperature range. 

 

Medical Device. 

 

Logo. 

 

Identifies the control by means of which the instrument is switched on from (or returned to) a 

standby condition. A long press to turn enter standby. A short press to wake the device from 

standby. 

 

3.3. SAFETY INSTRUCTIONS 

3.3.1. GENERAL 

The following safety precautions must be observed at all times. General safety precautions must be followed when 

operating electrical equipment. Failure to observe these precautions could result in damage to the equipment and injury 

to the operator or patient.  

The employer should instruct each employee in the recognition and avoidance of unsafe conditions and the regulations 

applicable to his or her work environment to control or eliminate any hazards or other exposure to illness or injury.  

Amplivox Ltd. is aware that safety rules within individual organizations vary. If a conflict exists between the instructions 

in this manual and the rules of the organization using this instrument, the more stringent rules should take precedence.  

The PC850 is intended to be used by hearing healthcare professionals (i.e. ENT doctors, audiologists), nurses or 

technicians who have been trained in the proper use of the device. 

 

  

In the unlikely case of a serious incident, inform Amplivox as well as the competent  
authority in the country where the user is established.   
  

 

3.3.2. CAUTIONS – GENERAL 

 

If the system is not functioning properly, do not operate it until all necessary repairs are made and the unit is tested and 

calibrated for proper functioning in accordance with Amplivox’s specifications. 

Do not drop or in any other way cause undue impact to this device. If the instrument is damaged, return it to the 

manufacturer for repair and/or calibration. Do not use the instrument if any damage is suspected. 

CAUTION 
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This product and its components will perform reliably only when operated and maintained in accordance with the 

instructions contained in this manual, accompanying labels, and/or inserts. A defective product should not be used. 

Make sure all connections to external accessories are secured properly. Parts which may be broken or missing or are 

visibly worn, distorted, or contaminated should be replaced immediately with clean, genuine replacement parts 

manufactured by or available from Amplivox Ltd. 

Equipment is not user repairable. Repairs must be performed by an authorized service representative only. No 

modifications of the equipment are allowed by anyone other than a qualified Amplivox Ltd. representative. Modification 

of the equipment could be hazardous. 

Amplivox Ltd. will make available on request circuit diagrams, component part lists, descriptions, calibrations 

instructions, or other information that will assist authorized service personnel to repair those parts of this instrument 

that are designated by Amplivox Ltd. as repairable by service personnel.  

No parts of the equipment can be serviced or maintained while in use with the patient. 

Connect only accessories purchased from Amplivox Ltd. to the PC850. Only accessories which have been stated by 

Amplivox Ltd. to be compatible are allowed to be connected to the device or cradle. 

To comply with the standards IEC 60601-1 for safety and IEC 60601-1-2 for electromagnetic compatibility (EMC) the 

audiometer is designed to be used only with the medically-approved mains adapter supplied, which is specified as part 

of the equipment. Do not use any other type of mains adapter with this instrument. 

The output from the mains adapter is fitted with electronic circuit protection. In case of overload the adapter will shut 

down and the indicator will be extinguished. When the fault is cleared the adapter will operate as normal.  

The input to the mains adapter is protected with a non-replaceable fuse. If this fails the adapter will not operate. 

The mains adapter is the mains disconnect device and therefore the audiometer should be positioned such that easy 

access to the mains adapter is possible. 

 

3.3.3. ENVIRONMENTAL FACTORS 

 

Use and store the instrument indoors only. It is recommended that the instrument be 

operated within an ambient temperature range of 15 °C / 59 °F to 35 °C / 95 °F and in 

relative humidity between 30 % and 90 % (non-condensing). 

Do not use the device in the presence of fluid that can come into contact with any of the electronic components or 

wiring. Should the user suspect fluids have contacted the system components or accessories, the unit should not be 

used until deemed safe by an authorized service technician. 

 

3.3.4. ELECTRICAL AND ELECTROSTATIC SAFETY 

 

Before performing any service to the insert earphones you must uncouple the PC850 

transducers from the patient. 

 

CAUTION 

CAUTION 
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Do not touch the contacts on the back of the instrument and the patient at the same 

time. The consequence could be a too high leakage current to the patient. 

Do not open the case of the instrument. Refer servicing to qualified personnel. 

This equipment is intended to be connected to other equipment thus forming a Medical Electrical System. External 

equipment intended for connection to signal input, signal output or other connectors must comply with the relevant 

product standard e.g. IEC 60950-1 for IT equipment and the IEC 60601-series for medical electrical equipment. In 

addition, all such combinations – Medical Electrical Systems – must comply with the safety requirements stated in the 

general standard IEC 60601-1, (edition 3.1), clause 16. Any equipment not complying with the leakage current 

requirements in IEC 60601-1 must be kept outside the patient environment i.e. at least 1.5m from the patient support 

or must be supplied via a separation transformer to reduce the leakage currents. Any person who connects external 

equipment to signal input, signal output or other connectors has formed a Medical Electrical System and is therefore 

responsible for the system to comply with these requirements. If in doubt, contact a qualified medical technician or 

your local representative. When the instrument is connected to a PC, or other similar items, beware of not touching the 

PC and patient simultaneously. 

A Separation Device (isolation device) is needed to isolate the equipment located outside the patient environment from 

the equipment located inside the patient environment. In particular such a Separation Device is required when a 

network connection is made. The requirement for the Separation Device is defined in IEC 60601-1 clause 16. 

Do not use any additional multiple socket-outlet or extension cord. Use only UES12LCP Power Supply. 

 

3.3.5. ELECTROMAGNETIC COMPATIBILITY (EMC) 

 

Although the instrument fulfills the relevant EMC requirements, precautions should be 

taken to avoid unnecessary exposure to electromagnetic fields, e.g., from mobile 

phones, etc. If the device is used adjacent to other equipment it must be observed that 

no mutual disturbance appears. Please also refer to the appendix regarding EMC. 

 

3.3.6. IT NETWORK 

  

Please note that connecting the device to a PC implies connecting the device to an IT-
network. The connection to an IT-network may result in previously un-identified risks 
which must be identified, analysed, evaluated, and mitigated by the responsible 
organisation.  
Any change to the IT-network (network configuration, (dis)connection of items, update or 
upgrade of equipment) may introduce new risks that require additional analysis.   
  

3.3.7. EXPLOSION HAZARDS  

 

Risk of explosion.  

Do not use in the presence of flammable anesthetics or other gases. 

Do NOT use in the presence of flammable gaseous mixtures. Users should consider the 

possibility of explosions or fire when using this device in close proximity to flammable 

anesthetic gases.  

Do NOT use the PC850 in a highly oxygen-enriched environment, such as a hyperbaric 

chamber, oxygen tent, etc. 

 

WARNING 

CAUTION 

WARNING 
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3.3.8. MEASURING SECURITY 

To guarantee that the PC850 works properly, the instrument should be checked and calibrated at least once a year. The 

transducers supplied with the audiometer are specifically calibrated with it; if these transducers are changed 

recalibration will be required. 

The service and calibration must be performed by an authorized service technician. If these checks are not performed, 

EU Medical Device Regulation (MDR) and other regulations may be violated and warranties may be void. 

The use of non-calibrated devices can lead to incorrect test results and is not advisable.  

 

3.3.9. MISCELLANEOUS 

Please note: DO NOT connect the PC850 hardware to the computer before the software has been installed! 

Storage in temperatures below 0C /32F and above 50C /122F may cause permanent damage to the instrument and 

its accessories. 

Do not place the instrument next to a heat source of any kind. 

Great care should be exercised when handling transducers, as rough handling, for example dropping onto a hard surface 

may break or damage the parts. 

 

Within the European Union it is illegal to dispose of electrical and electronic waste as unsorted 
municipal waste. Electrical and electronic waste may contain hazardous substances and therefore have 
to be disposed of separately. Such products will be marked with the crossed-out wheelie-bin image 
shown to the left. User cooperation is important in order to ensure a high level of reuse and recycling 
of electrical and electronic waste. Failure to recycle such waste products in an appropriate way may 
endanger the environment and consequently the health of human beings. 

Outside the European Union, local regulations should be followed when disposing of the product after its end of life. 

 

3.3.10. USE OF EQUIPMENT AFTER TRANSPORT AND STORAGE 

Please make sure that the instrument is functioning correctly before use. If the instrument has been stored in a cold 

environment (even for short period of time), please allow the instrument to become acclimatized. This can take long 

time depending on the conditions (such as environmental humidity). You can reduce the condensation by storing the 

instrument in its original packaging. If the instrument is stored under warmer conditions than the actual use conditions 

no special precaution is required before use. Always ensure proper operation of the instrument by following routine 

check procedures for audiometric equipment. 
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3.4. CONNECTIONS 

The accessory terminals and connections are labelled to ensure correct identification and connection as follows: 

 

 

1 Right 

Left 

Air conduction headset * 6.3mm jack 

6.3mm jack 

2 N/A Reserved port; Amplivox diagnostic use only 6 pin mini DIN 

3 USB Computer (via USB port) USB Connector, Type B 

4 N/A Reserved port; Amplivox diagnostic use only 6 pin mini DIN 

5 Power Mains AC/DC Adapter  2.5mm power jack 

6 Response Patient Respone Switch * 6.3mm jack 

7 Power Switch On / Off Switch  

For connected parts marked * only connect the accessories supplied with the instrument or supplied by Amplivox or an 

Amplivox distributor. These parts have been tested for use with the Amplivox PC850 Audiometer for compliance with 

the standards IEC 60601-1 and IEC 60601-1-2. The use of accessories other than those specified may compromise 

compliance with these standards. For other sockets refer to Appendix 2. 

 Please note: Only connect the accessories supplied with the instrument or supplied by Amplivox or an Amplivox 

distributor. These parts have been tested for use with the Amplivox PC850 audiometer for compliance with the 

standards IEC 60601-1 and IEC 60601-1-2. The use of accessories other than those specified may compromise 

compliance with these standards.  

 

  

6 1 2 3                4         5 7 
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4. USING THE PC850 (COMPUTER CONTROLLED) 
 

4.1. GENERAL  

 Please note: Before the PC850 can be used as an automatic audiometer, the operating software and the Audibase 

application must be installed and registered on the connected PC. Refer to the relevant section of the Audibase 

operating manual for details of this operation. 

On start-up the display will show the following default setting: 

SIGNAL dBHL   FREQUENCY Hz 

 30dB                            1kHz 

 < >           < >       

 

This indicates that the audiometer is now ready to be used for automatic testing which is initiated by Audibase and 

controlled by the PC850 software. 

4.2. SWITCHING THE AUDIOMETER ON AND OFF 
 

Press and briefly hold the switch marked  (located on the back panel). No warm-up time is required. The display will 

briefly show the model and the type of headphone currently in use. To switch off, press the switch marked  again, 

or press and hold the MENU key followed by the YES (RIGHT) key and then release both. 

 

4.3. USING THE TALKOVER FUNCTION 

If the TALKOVER key is pressed while an automatic test is in progress the test will be paused with a dialogue box 

displayed as below.  

 

After any necessary instruction is given to the patient and the TALKOVER key is released, the operator can choose to 

stop the test (“Abort”), retry the frequency that was being tested when the TALKOVER key was pressed (“Retry”), or 

skip the frequency that was being tested and move on to the next frequency (“Ignore”). 

4.4. STARTING THE SOFTWARE 

 Please note: Before starting an automatic test it is important to clear any current test readings from the 

audiometer (typically these would be retained thresholds from a previous manual test). If this is not done then dealing 

with any error conditions could become problematic. 
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Start the Audibase application, and with reference to the user manual either establish a new a patient, or access and 

display details of an existing patient. 

 

 

Use the left mouse button to click on the Launch Test icon in the Audibase toolbar. 

 

Alternatively use the “Test > Launch Test” drop-down menu selection at the top of the Audibase window. 

 

A new window will open for the PC850 software. If the patient has more than one set of audiometric results stored in 

Audibase the most recent audiogram is transferred and displayed in the PC850 window. 

 
 

The test type last used is remembered; if this was a manual test the procedures may be followed; if this was an 

automatic test the following dialogue box will be displayed: 

 
 

 

4.5. AVAILABLE TEST MODES 

4.5.1. MANUAL TEST 

While not strictly an “automatic” test, this allows the operator to use the PC850 software to transfer to Audibase the 

results of a previous manual test. These could be either the “retained thresholds” (see Section 5.3) or the thresholds 

stored in one of the internal memory locations of the audiometer (see Section 5.4). The audiometric data is 

transferred to Audibase in the same way as that for an automatic test. 
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4.5.2. COMPUTER TESTING 

This is a method of automatic audiometry based on the Hughson and Westlake method and undertaken automatically 

by the instrument. The level is increased in 5dB steps until a response is obtained from the patient and decreased in 

10 dB steps until no response occurs. The process is repeated until, depending upon the criteria selected for recording 

a threshold (see Section 4.4), the instrument will record a threshold at that particular frequency. The PC850 then 

continues to the next test frequency and so on to complete the test on both ears. When completed the test data is 

transferred to Audibase. 

4.5.3. BÉKÉSKY TEST 

This is a method of automatic audiometry devised by Von Bekesy (1947) using pure tone stimuli to track auditory 

thresholds. 

 

This application is known as discrete frequency Bekesy testing and the principle behind the test is that the patient 

adjusts the presented level according to his hearing threshold. The decibel level decreases when the patient presses 

the response switch upon hearing the presented tone. Conversely when the patient can no longer hear the presented 

tone, he will release the response switch therefore allowing the level to increase until the presented tone is heard 

again. The level changes are in 2.5dB steps. 

 

When a number of these "peaks" and "valleys" have been consistently performed, the PC850 will calculate an average 

to the nearest dB and display this as the hearing threshold for that particular frequency. The PC850 then continues to 

the next test frequency and so on to complete the test on both ears. 

4.5.4. SINGLE FREQUENCY TEST 

The PC850 provides the facility to repeat a test at a specified single frequency and add the results into the overall 

audiogram result. This feature is useful for situations where one particular frequency has proved problematic. 

4.5.5. MIXED TESTING 

This allows manual testing of any frequencies when an automatic test has been unable to determine a threshold. The 

combined results are then transferred to Audibase. 
 

4.6. INITIATING A TEST VIA COMPUTER 

Start the Audibase application, and with reference to the user manual either establish a new a patient, or access and 

display details of an existing patient. 

 

Use the left mouse button to click on the Launch Test icon in the Audibase toolbar. 

 

Alternatively use the “Test > Launch Test” drop-down menu selection at the top of the Audibase window. 

 

A new window will open for the PC850 software. If the patient has more than one set of audiometric results stored in 

Audibase the most recent audiogram is transferred and displayed in the PC850 window. 

 

The serial number and calibration date of the connected PC850 audiometer is shown at the bottom right of the PC850 

window along with the test type currently selected. 

 

The test type last used is remembered; if this was a manual test the procedures described in Section 4.4 may be 

followed; if this was an automatic test the following dialogue box will be displayed: 
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To run the same automatic test using the same options (as last used) simply click the “Start test” button and the test 

will commence (refer to Section 4.5). 

 

If a manual test is required, or if the test options are to be modified, click the “Modify” button which will close the 

dialogue box. Refer to Sections 4.4 to 4.7 and Section 5 as appropriate for additional guidance. 

 

4.7. RUNNING A PREVIOUS TEST TYPE 

To run the same type of test with the same options as previously used simply click “Yes” and the test will commence as 

previously run (refer to Sections 4.3.5 to 4.3.9). The “Run selected test” icon will change the following icon:  

Assuming that an automatic test is in use, the serial number of the connected audiometer is shown at the bottom right 

of the PC850 window and the status message “Running test” is displayed at the bottom left. Additionally, the message 

“Linked” is shown on the display of the audiometer. 

To view the traces of the presented tones select the “Show test detail” icon . 

Alternatively use the “View > Detail” drop-down menu option. 

To view the audiogram thresholds select the “Show Audiogram” icon . 

Alternatively use the “View > Audiogram” drop-down menu option. 

If thresholds are established at all of the selected test frequencies, the automatic test will finish with the following 

dialogue box displayed: 

 

Click “CONTINUE” to keep the PC850 program window open; this allows the user to perform further testing if required 

- for example to repeat a threshold at a particular frequency. 

Click “ACCEPT” to exit the PC850 program and transfer the complete test thresholds to Audibase. 

 Please note:  When transferring thresholds to Audibase, remember to “save” the data in Audibase to store it in 

the database (refer to the Audibase operating manual). If the data is not to be stored then the “Edit > Cancel Insert/Edit” 

menu option in Audibase is used to discard it, or click the cancel insert/edit button on the Audibase toolbar . 



   
 USING THE PC850 (COMPUTER CONTROLLED) 

 
 

18   PC850 INSTRUCTION FOR USE 
 

When data is saved in Audibase a further dialogue box appears similar to that shown below. This displays the hearing 

level categorisation and provides an opportunity for the operator to enter a recall period for the patient. 

 

 

Enter the appropriate recall period from the drop-down options and click on “OK” to confirm saving of the data. Clicking 

on “Cancel” will cancel the save operation and discard the data. 

Users should remain aware that it is possible to modify audiometric test results transferred into Audibase as long as 

they have not been saved. Refer to the Audibase manual for details. 

 

4.8. MANUAL TESTING  

This assumes that a set of audiometric thresholds has already been established by using the audiometer in manual test 

mode. 

Click the “Select upload manual test” icon (the icon will then be highlighted) . 

Alternatively use the “Test > Manual” drop-down menu selection at the top of the PC850 window. 

To transfer a set of manual thresholds to Audibase click the “Run selected test” icon  and confirm the operation 

by clicking “Yes” in the Run Test dialogue box. A further dialogue box will open. 

 

This allows either the “Current readings” (i.e. the retained thresholds) or the thresholds stored in one of the 

audiometer’s internal memory locations to be transferred to Audibase. To select an internal memory location un-check 

the “Current readings” box and enter the required memory location (numbers 1 to 12). 

Click on OK, and the selected data will be transferred to Audibase when the PC850 window is closed. Remember to 

“save” the data in Audibase to retain it in the database (refer to the Audibase operating manual). 

Note that the manual test method described above will transfer only thresholds stored in the audiometer. The results 

of any (partial) automatic test will be discarded. Thus, if an automatic test has been completed but with errors, the 

“Mixed Test” mode should be used to insert manual readings into the incomplete automatic test. 
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4.9. COMPUTER TESTING 

Click the Computer test button (the button will then be highlighted) 

 
 

Alternatively use the “Test > Computer” drop-down menu selection at the top of the PC850 window. A screen similar 

to that shown is displayed but with the “Present” icon and cursor removed. 

 

To run a full Computer test on both ears simply click the “Run selected test” button. 

 
 

Alternatively use the “Test” drop-down menu option to select either a full test or a restricted test (for example, 

limited to a single ear). 

 

The Computer test will run according to the test options selected with the test status indicated at the bottom left of 

the PC850 window. The “Present” icon will re-appear and indicate when tones are presented, and the “Response” 

icon will change to light green when a patient response is made. 

 

To view the traces of the presented tones select the “Show test detail” button: 

 
Alternatively use the “View > Detail” drop-down menu option. 

 

To view the audiogram thresholds select the “Show Audiogram” button: 

 
Alternatively use the “View > Audiogram” drop-down menu option. 

 

The order of frequencies tested, assuming that all frequencies are selected, are 1kHz, 1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz, 

8kHz, 500Hz and 250Hz. 

 

The time available for the patient to respond is from the point the tone is presented to the beginning of the next 

presented tone (approximately 2.3 seconds maximum). If a response is made within this time period a random delay is 

then added to the time until the next tone is presented. 

 

Once the test has been completed successfully the following dialogue box will be displayed: 

 

 
 

If the test has not been completed successfully the following dialogue box will be displayed: 
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To accept the results and transfer them to Audibase click on the “Accept” button. The PC850 window will close and 

the Audibase window will be displayed. Refer to the Audibase user manual for additional options, but it should be 

noted that the results must be saved in Audibase to be retained in the database. 

 

To continue testing click on the “Continue” option. The dialogue box will close and the operator may continue testing 

as described in these sub-sections. 

 

4.10. BÉKÉSKY TEST 

Use the audiometer controls to clear any current test readings (retained thresholds). 

Click the “Bekesy” test icon (the icon will then be highlighted) . 

Alternatively use the “Test > Bekesy” drop-down menu selection at the top of the PC850 window. 

To run a Bekesy test click the “Run selected test” icon  and confirm the operation by clicking “Yes” in the Run Test 

dialogue box. 

The Bekesy test will run according to the test options selected with the test status indicated at the bottom left of the 

PC850 window. 

The time available for the patient to respond in Bekesy mode is from the point the tone is presented until the point 

when the next tone in the sequence is presented. 

The test will proceed and conclude as described. Remember to “save” the data in Audibase to retain it in the database 

or “Cancel Insert/Edit” if the data is to be discarded (refer to the Audibase operating manual). 

 

4.11. SINGLE-FREQUENCY TESTING 

This option allows an automatic test at a single frequency to be repeated, for example if the full automatic test has been 

unable to record a threshold. 

Use the “Test > One freq. test” drop-down menu selection at the top of the PC850 window to select the single frequency 

from those available for testing. 

An automatic test at that frequency will be performed and the test will proceed. Remember to “save” the data in 

Audibase to retain it in the database or “Cancel Insert/Edit” if the data is to be discarded (refer to the Audibase operating 

manual). 

 

4.12. MIXED-MODE TESTING 

This allows manual readings to be inserted at frequencies at which an automatic test has been unable to establish a 

threshold. In these circumstances the automatic test would finish with the following dialogue box displayed: 
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Click “CONTINUE” and note the frequencies at which thresholds were not established. Only click “ACCEPT” if you wish 

to exit the PC850 program and transfer the incomplete test to Audibase. 

Return to the audiometer and use it to manually determine thresholds at these frequencies (refer to Section 5). It will 

be easier to do this if any previous displayed results (the “retained thresholds”) have been cleared. 

When the required manual test results have been established on the audiometer click the “Select insert manual 

readings” icon (the icon will then be highlighted) . 

Alternatively use the “Test > Mixed” drop-down menu selection at the top of the PC850 window. 

To transfer the combined thresholds to Audibase click the “Run selected test” icon  and confirm the operation by 

clicking “Yes” in the Run Test dialogue box. A further dialogue box will open. 

 

In this case leave “Current readings” selected, click on OK, and the combined data will be transferred to Audibase when 

the PC850 window is closed. Remember to “save” the data in Audibase to retain it in the database (refer to the Audibase 

operating manual). 

Note that any automatic test thresholds recorded will always be transferred, even if a threshold has been manually 

entered on the audiometer at that frequency. Only manual thresholds entered at frequencies where there is no 

automatic test threshold are transferred to Audibase. 

Note also that if the previous test results on the audiometer (the “retained thresholds”) were not cleared then any 

retained thresholds at frequencies where an automatic test was not carried out (e.g. for frequencies that were 

deselected for an automatic test) would also be transferred into Audibase. This is why it is essential to clear the retained 

thresholds before carrying out an automatic test. 
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5. USING THE PC850 STAND-ALONE 
5.1. GENERAL  
Manual testing with the audiometer in “standalone” mode may be carried out with or without the connection to the 

PC. If an automatic test has been launched by Audibase then manual testing is not possible until this has concluded. 

 

5.2. SWITCHING THE AUDIOMETER ON AND OFF 
 

Press and briefly hold the switch marked  (located on the back panel). No warm-up time is required. The display will 

briefly show the model and the type of headphone currently in use. To switch off, press the switch marked  again, 

or press and hold the MENU key followed by the YES (RIGHT) key and then release both. 

 

5.3. AUDIOMETER DISPLAY 

On start-up the display will show the following default setting:- 

SIGNAL dBHL   FREQUENCY Hz 

 30dB                            1kHz 

 < >           < >       

This indicates that when the PRESENT key is pressed, a tone will be presented at 30dBHL at a frequency of 1kHz to the 

indicated ear. On start up the audiometer defaults to the left ear.  

 

5.4. AUDIOMETER CONTROLS 

5.4.1. MULTIFUNCTION KEYS 

Several keys on the audiometer have different functions depending on the actual mode of operation. These are MENU 

(OFF), LEFT (NO), RIGHT (YES) and FREQUENCY   (MENU SELECT). The use of these keys is described below. 

5.4.2. MENU 

Press and hold MENU to access the following options. Use the MENU SELECT keys to step through the available options 

and then the NO, YES or SIGNAL  keys to select an action or modify a setting. Release of the MENU key then initiates 

the action or saves the modified setting and returns to the default display. 

Menu Option            Description 

Switch off?:            Press Power Button. 

Clear test?: Press YES and release MENU to clear the Threshold Retention 

Function results from the previous test 

Save audiogram to (1): Use the SIGNAL  keys to select the required storage location and 

press the YES key to save the audiogram; then release MENU 

Load audiogram no (1): Use the SIGNAL  keys to select the required storage location and 

press the YES key to load the audiogram; then release MENU 

Contrast:  Adjust contrast using the SIGNAL   keys; then release MENU 
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5.4.3. DESCRIPTION OF FUNCTION OF OTHER KEYS 

+20dB      This enables tone levels to be presented with up to 20dB higher output in manual test 

mode; press the key and then use SIGNAL  to access the extra 20dB in 5dB steps; an 

indicator above the key illuminates green to show that the function is active 

TALK OVER Hold this key to interrupt the test and route the operator’s voice from the front panel 

microphone to the headset; the level is adjusted with the SIGNAL  keys 

LEFT Press once to select the left ear (the indicator above the key illuminates green); if the left 

ear is already selected, press again to store the displayed signal value as a threshold (see 

Section 5.3) 

RIGHT Press once to select the right ear (the indicator above the key illuminates green); if the 

right ear is already selected, press again to store the displayed signal value as a threshold 

(see Section 5.3) 

SIGNAL Press the  keys to decrease or increase the level of the tone presented in 5dB steps; to 

scroll through the range keep the key pressed 

FREQUENCY Press the  key to select a lower frequency and the  key to select a higher frequency 

PRESENT Press to present the displayed test signal to the patient. The “PRESENT” indicator above 

the display will be illuminated green during tone presentation 

 

5.5. THRESHOLD RETENTION FUNCTION 

This function allows the thresholds determined for each ear and each frequency to be stored and displayed for 

reference. 

The operator can then review the results at the end of the test and record them on an audiogram card, transfer them 

into the internal memory or transfer the results into the Amplivox Audibase application. 

Once a threshold has been determined press the “selected” ear key once again and the level will be stored 
and displayed in a similar way to that shown below. 
To review the retained thresholds, use the FREQUENCY  keys to select the required frequency. The threshold values 

for the left and right ears are shown on the lower line of the display as illustrated below. 

SIGNAL dBHL          FREQUENCY Hz  

  30dB                         4kHz  

 20          10 

This display shows 

thresholds at 4kHz  

Thresholds retained Left ear 20dBHL 

Right ear 10dBHL 

To clear the Threshold Retention memory, press and hold the MENU key, use the FREQUENCY  keys to select “Clear 

test?  No”. Press YES and then release the MENU key. 
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5.6. SAVING AUDIOGRAMS IN INTERNAL MEMORY 

The user may save up to 12 audiograms, referenced by number, in the internal memory of the audiometer. To save the 

current set of audiogram thresholds press and hold the MENU key, and then press MENU SELECT repeatedly until “Save 

Audiogram to 1” appears on screen. Use the SIGNAL  keys to select a location numbered 1-12, and then press the 

YES key. Release the MENU key once confirmation appears on the display. Note that the Save process will overwrite any 

records that exist in the selected memory location. 

 

5.7. LOADING AUDIOGRAMS FROM INTERNAL MEMORY 

Press and hold the MENU key, and then press MENU SELECT repeatedly until “Load Audiogram No 1” appears on screen. 

Use the SIGNAL  keys to select a location numbered 1-12, and then press the YES key. Release the MENU key once 

confirmation appears on the display. 

 

5.8. DATA TRANSFER TO AMPLIVOX AUDIBASE 

Refer to the Audibase operating manual to transfer test results to a PC with the Amplivox Audibase software installed. 

 

5.9. SUGGESTED SEQUENCE OF OPERATION AND TEST PROCEDURE 

The following notes are for guidance only. Refer also to ISO 8253 (Audiometric Test Methods) for further guidance. 

5.9.1. PRE-TEST 

(1) Switch the audiometer on 
(2) Perform a listening check 
(3) Decide whether to use the Threshold Retention Function and/or an audiogram card to record the thresholds 
(4) Prepare the test environment & patient 
(5) If the patient response switch is not being used give instructions to the patient to acknowledge any tone 

presented by raising or lowering the finger 
(6) If the patient response switch is in use give instructions to the patient to acknowledge any tone presented as 

follows: 
“As soon as you hear the tone, press the switch. When you no longer hear the tone, release the switch”. 

(7) Fit the headset to the patient. Select the better hearing ear (according to the patient) by pressing either the LEFT 
or RIGHT key and start the familiarisation session. 

5.9.2. FAMILIARISATION 

(1) Present the tone 30dB at 1kHz for between 1 and 2 seconds. If there is no response at 30dB, increase the 
attenuation level in 10dB steps until the patient responds 

(2) When the patient responds, wait for 1 to 2 seconds and present the tone again at the same level; however, if the 
patient does respond at 30dB, reduce the signal level in 10dB steps, repeating the presentation until there is no 
response, then increase the signal level in 5dB steps until the patient responds; wait 1 to 2 seconds and present 
the tone again at the same level 

(3) If the responses are consistent with the pattern of tone presentation, start measuring the patient’s hearing 
thresholds; if not, repeat the familiarisation 

 

5.9.3. TEST 

(1) Use the Clear test option to clear any thresholds 
(2) Present the first test tone at 30dB at 1kHz 
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(3) If the patient responds, reduce the signal level in 10dB steps repeating the presentation until there is no 
response; then increase the signal level in 5dB steps until the patient responds 

(4) If the patient does not respond, increase the signal level in 5dB steps until there is a response and then continue 
with step 5. 

(5) Repeat the test by reducing the signal level in 10dB steps until the patient no longer responds. Then increase the 
signal level in 5dB steps until a response occurs and note this level. 

(6) Repeat step 5 until the patient responds three out of a maximum of five times at the same signal level. This 
indicates the patient’s hearing threshold level for that frequency. Either mark the threshold on an audiogram card 
or press the appropriate ear key once to activate the Threshold Retention Function and save the threshold level 
on screen. 

(7) Proceed to the next test frequency. It is common practice to test the frequencies in the following order: 1k, 2k, 
3k, 4k, 6k, 8k and 500 Hz. 

(8) Repeat steps 2 to 7 for the other ear. 
 

5.9.4. POST-TEST 

(1) Use the Threshold Retention Function to review the results 
(2) If required do one or more of the following: 

• Record the results on an audiogram card, or 

• Save the results to the internal memory, or 

• Transfer the results to a computer 
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6. OPTIONS AVAILABLE TO SET-UP  

6.1. GENERAL 

The PC850 software stores the most recent test configuration and will initially use this to run any subsequent tests. 

However, there are a number of options available for setting up, modifying and controlling a test. These are summarised 

below - please refer to the operating window of the PC850 Software. 

 

The “Options” menu selection at the top of the PC850 window opens a dialogue box, which provides access to a number 

of options as follows: 

 

• Frequencies, which allows the operator to add or delete specific frequencies to or from the test regime; note 
that 1kHz is always included  

• Computer test, which provides controls to allow: 
o the selection of either 2 out of 3, or 3 out of 5 consistent responses to generate a valid threshold 
o a familiarisation run prior to the test 
o a retest of the first frequency to be omitted (including this function can prove useful in correlating 

test results) 

• Tone response, which provides controls to determine the action to be taken on error: 
o the number of times a frequency is repeated (0, 1, 2 or 3 times) if an error in testing occurs (for 

example, if there is no response from the patient) 
o and then the action to be taken if the error continues (skip the frequency, stop the test or pause the 

test) 

• Patient details, which may be ignored when used with Audibase 

• COM, which may be ignored for instruments with serial numbers covered by this user guide 

• Colour display, which may be selected to display the audiogram in colour 

• Colour print, which may be ignored when used with Audibase 

• Beep on finish, which sounds an audible warning on the PC at the end of the test 
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7. TROUBLESHOOTING 

7.1. NO INSTRUMENT CONNECTED 

If no audiometer has been connected when a test is requested from Audibase a dialogue box similar to that shown 

below will be displayed:  

 

Check: 

• That the PC850 audiometer is switched on 

• That the PC850 audiometer is connected to the computer 

• That the PC850 software has been installed correctly 
 

Click OK to close the box and then use the “Edit > Cancel Insert/Edit” option to cancel the operation. Audibase functions 

may then be continued. 

 

7.2. WRONG PASSWORD 

If this error message is seen the audiometer is being used with a version of Audibase older than Version 5.5. Please refer 

to the documentation supplied with the previous version. 

 

7.3. NO RESPONSE FROM PATIENT 

If the patient does not operate the response switch and the maximum output level is reached the following dialogue 

box will be displayed: 

 

Check: 

• That the earphones and response button are correctly plugged in 

• That the audiometer is presenting a tone  

• That the Patient Response Switch is working correctly 

• That the patient understands the test and that they understand how to respond to the tones presented 
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The operator can choose to stop the test (“Abort”), retry the frequency (“Retry”) or skip the frequency that was being 

tested and move on to the next frequency (“Ignore”). 

 

7.4. CONTINUAL RESPONSE FROM PATIENT 

If the patient holds the response switch on continuously it will not be possible to record a hearing threshold and the 

following dialogue box will be displayed: 

 

The operator can choose to stop the test (“Abort”), retry the frequency (“Retry”) or skip the frequency that was being 

tested and move on to the next frequency (“Ignore”). 

 

7.5. NO RESULTS 

If no results are available to transfer to Audibase the following dialogue box will be displayed: 

 

This could be because the PC850 window was closed before any thresholds could be recorded, the test was aborted or 

some other problem has occurred with the test sequence. Click OK to close the box and then use the “Edit > Cancel 

Insert/Edit” option to cancel the operation. A further test may then be launched from Audibase. 

 

7.6. ERRORS IN TEST SEQUENCE 

If one or more thresholds cannot be recorded the following dialogue box is displayed at the end of the test: 

 

Click “CONTINUE” to keep the PC850 program window open; this allows the user to perform further testing.  

Click “ACCEPT” to exit the PC850 program and transfer the incomplete test thresholds to Audibase. 
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7.7. INCONSISTENCY IN 1KHZ REPEAT TEST 

If the repeat frequency option is enabled for a Computer test an additional test at 1kHz is carried out at the end of the 

test and compared with the original test result at this frequency. 

If the two results differ by 10dB or less then the second result is recorded as the threshold at 1kHz and the test continues. 

If the two results differ by more than 10dB the following dialogue box is displayed. 

 

The operator can choose to stop the test (“Abort”), retry the repeat frequency (“Retry”) or skip the repeat frequency 

and continue the test (“Ignore”). If the Ignore option is selected the second result is recorded as the threshold at 1kHz. 

 

7.8. USB LEAD DISCONNECTED 

If the cable connecting the PC850 to the PC becomes disconnected any automatic test running will cease. It may take 

the audiometer a few moments before the test stops. It may be possible to select control buttons and menus options 

in the PC850 window on the PC but these will have no effect. Reconnecting the USB lead will also have no effect. 

Depending on the task in process when disconnection occurred, one or more error messages may be displayed; for 

example: 

 

If possible use the “File > Exit” drop-down menu selection at the top of the PC850 window. This should close the PC850 

window and return to Audibase. Further error messages may appear, for example: 

 

If possible, use the use the “Edit > Cancel Insert/Edit” option in Audibase to discard any data, and then close Audibase. 
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Depending on the task in process when disconnection occurred, the audiometer may lock up and not respond to the 

controls. If possible, attempt to switch off the audiometer. Then remove the power from the audiometer for several 

seconds. The PC850 may then be reconnected and Audibase started as usual. 

 

7.9. ACCIDENTAL CLOSURE OF PC850 PROGRAM 

If the PC850 program is closed while an automatic test is running the test will end and the “No results” message will be 

displayed in Audibase. It will be necessary to switch the audiometer off and on. Clear any test results and re-start the 

test. 
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8. ROUTINE MAINTENANCE 

8.1. GENERAL MAINTENANCE PROCEDURES 

The performance and safety of the instrument will be maintained if the following recommendations for care and 

maintenance are observed: 

1. It is recommended that the instrument go through at least one annual service, to ensure that the acoustical, 

electrical and mechanical properties are correct. This should be carried out by an authorized repairer in order 

to guarantee proper service and repair. 

2. Observe that no damage is present to the insulation of the mains cable or the connectors and that it is not 

exposed to any kind of mechanical load that could involve damage. 

3. To ensure that the reliability of the instrument is maintained, we recommend that the operator at short 

intervals, for instance once a day, performs a test on a person with known data. This person could be the 

operator.  

4. If the surface of the instrument or parts of it is contaminated, it can be cleaned using a soft cloth moistened 

with a mild solution of water and detergent or similar. Always disconnect the mains power adaptor during the 

cleaning process and be careful that no fluid enters the inside of the instrument or accessories. 

5. After each patient examination, ensure that there has been no contamination to the parts touching the patient. 

General precautions must be observed in order to avoid cross-contamination of disease from one patient to 

another. Water should be used for frequent cleaning, but in the case of severe contamination it may be 

necessary to use a disinfectant.  

 

• Before cleaning always switch off and disconnect from the power supply 

• Use a soft cloth lightly dampened with cleaning solution to clean all exposed surfaces 

• Do not allow liquid to come in contact with the metal parts inside the earphones/headphones 

• Do not autoclave, sterilize or immerse the instrument or accessory in any fluid 

• Do not use hard or pointed objects to clean any part of the instrument or accessory 

• Do not let parts that have been in contact with fluids dry before cleaning 

• Rubber ear-tips or foam ear-tips are single use components 

 

Recommended cleaning and disinfection solutions: 

• Warm water with mild, nonabrasive cleaning solution (soap) 

• 70% isopropyl alcohol only on hard cover surfaces 

 

8.2. AUDIOMETER MAINTENANCE 

The PC850 audiometer is a precision instrument. Handle it carefully in order to ensure its continued accuracy and 

service. When cleaning the instrument, use a soft damp cloth and mild detergent to clean the instrument panel. Refer 

to ISO 8253-1 for additional guidance. 

 

CAUTION 
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8.3. HEADSET MAINTENANCE 

Before use check the headset cables and connectors for signs of wear and/or damage. If you find any, please replace 

the item immediately by contacting Amplivox or your Amplivox distributor, requesting the relevant part number. 

 

Handle the audiometric headset (and audiocups) with care. For these parts that are in direct contact with the patient 

it is recommended that they are subjected to a standard disinfecting procedure between patients. 

 

This includes physically cleaning and use of a recognised disinfectant. The specific manufacturer's instructions should 

be followed for use of this disinfecting agent to provide an appropriate level of cleanliness. 

 

Clean the ear cushions (including those on the Audiocups, if used) with a recognised disinfectant, e.g. a “Mediswab”. 

 

 Please note: During the cleaning process do not allow moisture to enter the earphone. 

 

8.4. ACCESSORIES/REPLACEMENT PARTS 

Some reusable components are subject to wear with use over time. We recommend that you keep theses replacement 

parts available. 

 

8.5. REPAIR 

Amplivox Ltd.is only considered to be responsible for the validity of the CE marking, effects on safety, reliability and 

performance of the equipment if: 

• assembly operations, extensions, readjustments, modifications or repairs are carried out by authorized persons 

• a 1 year service interval is maintained  

• the electrical installation of the relevant room complies with the appropriate requirements, and 

• the equipment is used by authorized personnel in accordance with the documentation supplied by Amplivox 

Ltd. 

It is important that the customer (distributor) fills out the RETURN REPORT every time a problem arises and sends it to  

Amplivox Limited 

3800 Parkside, Solihull Parkway,  
Birmingham Business Park,  
Birmingham, West Midlands,  
B37 7YG  
United Kingdom  

hello@amplivox.com 

This should also be done every time an instrument is returned to Amplivox Ltd. (This of course also applies in the unlikely 

worst case scenario of death or serious injury to a patient or user). 

When packing the instrument for shipping, please use the original shipping carton and packing materials. Place the 

instrument parts in plastic bags before packing. 

 

8.6. WARRANTY 

Amplivox therefore gives the purchaser the following Warranty; 

https://demant.sharepoint.com/sites/bhx_connect/Marketing/MARKETING%20DEPARTMENT/Archive/LITERATURE/INSTRUCTION%20FOR%20USE/PC850/2021-04%20CURRENT%20RELEASE/hello@amplivox.com
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If within twenty-four months from the date of dispatch, any defect in respect of material or workmanship within our 
control is discovered, we will make good the defect without charge, subject to the following conditions; 
 

• Notice of the fault is given to Amplivox within the Warranty period. 

• The instrument is forwarded, carriage paid, to Amplivox Limited at the above address or as otherwise 

directed. 

• The responsibility of Amplivox under this Warranty is strictly limited to making good the defect in the 

instrument itself. 

• No attempt has been made to effect a repair or adjust the calibration or alter the instrument from the 

original build standard.  

• Defects caused by abnormal conditions of use, accident or neglect are expressly excluded. 

If any product requires service during the applicable warranty period, the purchaser should communicate directly with 
the local Amplivox Ltd. service center to determine the appropriate repair facility. Repair or replacement will be carried 
out at Amplivox’s expense, subject to the terms of this warranty. The product requiring service should be returned 
promptly, properly packed, and postage prepaid. Loss or damage in return shipment to Amplivox Ltd. shall be at 
purchaser's risk.  
 
In no event shall Amplivox Ltd. be liable for any incidental, indirect or consequential damages in connection with the 
purchase or use of any Amplivox Ltd. product.  
 
This shall apply solely to the original purchaser. This warranty shall not apply to any subsequent owner or holder of the 
product. Furthermore, this warranty shall not apply to, and Amplivox Ltd. shall not be responsible for, any loss arising 
in connection with the purchase or use of any Amplivox Ltd. product that has been:  

• repaired by anyone other than an authorized Amplivox Ltd. service representative;  

• altered in any way so as, in Amplivox Ltd. opinion, to affect its stability or reliability;  

• subject to misuse or negligence or accident, or that has had the serial or lot number altered; defaced or 

removed; or  

• improperly maintained or used in any manner other than in accordance with the instructions provided by 

Amplivox Ltd. 

This warranty is in lieu of all other warranties, express or implied, and of all other obligations or liabilities of Amplivox 
Ltd. Amplivox Ltd. does not give or grant, directly or indirectly, the authority to any representative or other person to 
assume on behalf of Amplivox Ltd. any other liability in connection with the sale of Amplivox Ltd. products.  
 
AMPLIVOX LTD. DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING ANY WARRANTY OF 
MERCHANTABILITY OR FOR FUNCTION OF FITNESS FOR A PARTICULAR PURPOSE OR APPLICATION. 
 

8.7. CALIBRATION AND RETURN OF THE INSTRUMENT  

Amplivox recommends that the PC850 is calibrated annually.  
Please contact Amplivox or the designated distributor for details of calibration services. 
 

8.8. GUARANTEE 

All Amplivox instruments are guaranteed against faulty materials and manufacture. The instrument will be replaced 

free of charge for a period of three years from the date of despatch if returned, carriage paid, to the Amplivox service 

department. Return carriage is free of charge for customers in the UK and chargeable for overseas customers. 
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 Please note: The following exceptions apply: 

The earphones may go out of calibration due to rough handling or impact (dropping). The life of the leads is also 

dependent upon conditions of use. These parts are only guaranteed against faulty materials or manufacture. 
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9. TECHNICAL SPECIFICATIONS 

9.1. STANDARDS AND REGULATORY 

Type of protection against electric shock: Powered via SELV ClassII mains adapter 

Degree of protection against electric shock: Type B applied part 

Degree of protection against ingress of water: Not protected 

Mode of operation: Continuous operation 

Equipment mobility: Portable 

 

The Model PC850 Audiometer is classified as a Class IIa device under Annex VIII of the EU Medical Devices Regulation. 

It is intended for use as a screening audiometer instrument. 

 

Audiometer type: Type 4 (IEC 60645-1:2001) 

                                 Type 4 (ANSI S3.6:2004) 

 

Types and reference levels: DD45: ISO 389-1, Table 2 

Static headband force: Headphones: 4.5N 

Sound attenuation characteristics: ISO8253-1, Table 3 

 

9.2. INPUT/OUTPUT DATA 

Outputs:    Left & Right earphone 

Frequency range:   250Hz-8kHz 

Frequency accuracy:   <1% 

Distortion:   <2% 

Output level range:   -10dBHL min; 100dBHL max (all frequencies) 

Output level accuracy:   Within 3dB 

Output level step size:        5dB 

Output transducer (AC):   DD45 earphones (supplied) 

Tone present:   Single tone 

Communication:    Integral talk over facility 

USB interface:   Interface to PC (PC850 & Audibase software) 

Power input:   2.5mm barrel-type socket. 

Patient response input:   6.3mm Jack socket 

Left & Right outputs:   6.3mm Jack socket 

USB:   Type B socket 

Maximum voltage at any output: 12V peak 

 

9.3. PHYSICAL DATA 

Display: 2 lines of 24 characters 

Mains power: 100-240Vac; 50-60Hz; 0.5A 

Input Rating:  5Vdc; 1.2A 

Dimensions: 270mm (W) x 175mm (D) x 68mm (H) 

Weight: 0.7kg (approx) 

Safety: IEC 60601-1 (plus UL, CSA & EN deviations) 

EMC: IEC 60601-1-2 

CE mark: To the EU Medical Device Regulation 
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9.4. EARPHONE SOUND ATTENUATION CHARACTERISTICS 

Frequency, Hz 250 500 1000 2000 4000 8000 

Attenuation, dB 5 7 15 25 31 23 

 

9.5. ENVIRONMENTAL 

Operating temperature: +15oC to +35oC 
Storage/transport temperature: -20oC to +70oC 
Humidity (operating): 30% to 90% (non-condensing) 
Humidity storage/transport): 10% to 90% (non-condensing) 
Atmospheric Pressure (operating): 700hPa to 1060hPa 
Atmospheric Pressure 
(storage/transport):  
 

500hPa to 1060hPa 
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10. EMC GUIDANCE & MANUFACTURER’S DECLARATION 

 

• This instrument is suitable in hospital environments except for near active HF surgical equipment and RF 

shielded rooms of systems for magnetic resonance imaging, where the intensity of electromagnetic 

disturbance is high 

• Use of this instrument adjacent to or stacked with other equipment should be avoided because it could result 

in improper operation. If such use is necessary, this instrument and the other equipment should be observed 

to verify that they are operating normally 

• Use of accessories, transducers and cables other than those specified or provided by the manufacturer of this 

equipment could result in increased electromagnetic emissions or decreased electromagnetic immunity of 

this equipment and result in improper operation. The list of accessories, transducers and cables can be found 

in this appendix. 

• Portable RF communications equipment (including peripherals such as antenna cables and external antennas) 

should be used no closer than 30 cm (12 inches) to any part of this instrument, including cables specified by 

the manufacturer. Otherwise, degradation of the performance of this equipment could result 

NOTICE 

• ESSENTIAL PERFORMANCE for this instrument is defined by the manufacturer as:  

This instrument does not have an ESSENTIAL PERFORMANCE Absence or loss of ESSENTIAL PERFORMANCE 

cannot lead to any unacceptable immediate risk 

• Final diagnosis shall always be based on clinical knowledge There are no deviations from the collateral 

standard and allowances uses 

• This instrument is in compliance with IEC60601-1-2:2014, emission class B group 1 

NOTICE: There are no deviations from the collateral standard and allowances uses 

NOTICE: All necessary instruction for maintaining compliance with regard to EMC can be found in the general 

maintenance section in this instruction. No further steps required.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAUTION 
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Guidance and manufacturer’s declaration – electromagnetic emissions 

The PC850 Audiometer is intended for use in the electromagnetic environment specified below. The customer or 

user of PC850 Audiometer should assure that it is used in such an environment. 

Emissions test 
Compliance Electromagnetic environment – guidance 

RF emissions 

 

CISPR 11 

Group 1 
The PC850 Audiometer uses RF energy only for 

its internal function. Therefore, its RF emissions 

are very low and are not likely to cause 

interference in nearby electronic equipment. 

RF emissions 

 

CISPR 11 

Class B The PC850 Audiometer is suitable for use in all 

establishments, including domestic 

establishments and those directly connected to 

the public low-voltage power supply network that 

supplies buildings used for domestic purposes. Harmonic emissions 

 

IEC 61000-3-2 

Class A 

Voltage fluctuations/flicker 

emissions 

 

IEC 61000-3-3 

Complies 

 

 

 

Guidance and manufacturer’s declaration – electromagnetic immunity (1) 

The PC850 Audiometer is intended for use in the electromagnetic environment specified below. The customer or 

user of the PC850 Audiometer should assure that it is used in such an environment. 

Immunity test IEC 60601 test level Compliance level Electromagnetic 

environment – guidance 

Electrostatic Discharge (ESD) 

 

IEC 61000-4-2 

±8 kV contact 

 

±15 kV air 

±8 kV contact 

 

±15 kV air 

Floors should be wood, 

concrete or ceramic tile. If 

floors are covered with 

synthetic material, the relative 

humidity should be at least 

30% 
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Immunity test IEC 60601 test level Compliance level 
Electromagnetic 

environment – guidance 

Voltage dips, short interruptions 

and voltage variations on power 

supply input lines (100V/60Hz & 

240V/50Hz) 

 

IEC 61000-4-11 

0% UT 

(100% dip in UT) for 

0.5 cycle 

 

0% UT 

(100% dip in UT) for 1 

cycle 

 

40% UT 

(60% dip in UT) for 5 

cycles 

 

70% UT 

(30% dip in UT) for 

500ms 

 

0% UT 

(100% dip in UT) for 5 

sec 

0% UT 

100% dip in UT) for 0.5 

cycle 

 

0% UT 

(100% dip in UT) for 1 

cycle 

 

40% UT 

(60% dip in UT) for 5 

cycles 

 

70% UT 

(30% dip in UT) for 

500ms 

 

0% UT 

(100% dip in UT) for 5 

sec 

Mains power quality should be 

that of a typical commercial or 

hospital environment. If the 

user of the PC850 Audiometer 

requires continued operation 

during power mains 

interruptions, it is 

recommended that the PC850 

Audiometer be powered from 

an uninterruptible power 

supply or a battery 

Power frequency (50/60Hz) 

magnetic field 

 

IEC 61000-4-8 

30 A/m 30 A/m Power frequency magnetic 

fields should be at levels 

characteristic of a typical 

location in a typical 

commercial or hospital 

environment. 

 

 

 

 

 

 

 

 

 

 

 

  



   
 EMC GUIDANCE & MANUFACTURER’S DECLARATION 

 
 

40   PC850 INSTRUCTION FOR USE 
 

Guidance and manufacturer’s declaration – electromagnetic immunity (2) 

The PC850 Audiometer is intended for use in the electromagnetic environment specified below. The customer 

or user of the PC850 Audiometer should assure that it is used in such an environment. 

Immunity test IEC 60601 test 

level 

Compliance level Electromagnetic environment – guidance 

 

 

 

 

 

 

 

 

Conducted RF 

IEC 61000-4-6 

 

Radiated RF 

IEC 61000-4-3 

 

 

 

 

 

 

 

 

10 Vrms 

150kHz to 80MHz 

 

10 V/m 

80MHz to 2.7GHz 

 

 

 

 

 

 

 

 

10 Vrms 

150kHz to 80MHz 

 

10 V/m 

80MHz to 2.7GHz 

Portable and mobile RF communications 

equipment should be used no closer to any part 

of the PC850 Audiometer, including cables, than 

the recommended separation distance calculated 

from the equation applicable to the frequency of 

the transmitter. 

Recommended separation distance 

d = 1.2√P 

d = 1.2√P 80MHz to 800MHz 

d = 2.3√P 800MHz to 2.7GHz 

where P is the maximum output power rating of 

the transmitter in Watts (W) according to the 

transmitter manufacturer and d is the 

recommended separation distance in metres (m). 

 

Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site survey, a 

should be less than the compliance level in each 

frequency range. b 

Interference may occur in the vicinity of 

equipment marked with the following symbol: 

 

 

 

 

NOTE 1 At 80MHz and 800MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and 

land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted 

theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an 

electromagnetic site survey should be considered. If the measured field strength in the location in which 

the PC850 Audiometer is used exceeds the applicable RF compliance level above, the PC850 

Audiometer should be observed to verify normal operation. If abnormal performance is observed, 

additional measures may be necessary, such as re-orienting or relocating the PC850 Audiometer. 

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 

 



   
 EMC GUIDANCE & MANUFACTURER’S DECLARATION 

 
 

41   PC850 INSTRUCTION FOR USE 
 

 

Recommended separation distances between portable and mobile RF communications equipment and 

the PC850 Audiometer 

The PC850 Audiometer is intended for use in an electromagnetic environment in which radiated RF disturbances 

are controlled. The customer or the user of the PC850 Audiometer can help prevent electromagnetic interference 

by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) 

and the PC850 Audiometer as recommended below, according to the maximum output power of the 

communications equipment. 

Rated maximum output 

power of transmitter 

 

W 

Separation distance according to frequency of transmitter 

 

m 

150 kHz to 80 MHz 

 

d = 1.2√P 

 

80 MHz to 800 MHz 

 

d = 1.2√P 

800 MHz to 2.5 GHz 

 

d = 2.3√P 

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in 

metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the 

maximum output power rating of the transmitter in Watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80MHz and 800MHz, the separation distance for the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people. 

 

NOTE 3 WARNING: Portable RF communications equipment (including peripherals such as antenna cables and 

external antennas) should be used no closer than 30cm (12 inches) to any part of the PC850 audiometer including 

cables specified by the manufacturer. Otherwise degradation of the performance of this equipment could result. 
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11. USE WITH NON-MEDICAL ELECTRICAL EQUIPMENT 
Any person who connects external equipment to signal input, signal output or other connectors has created a medical 

electrical system and is therefore responsible for the system complying with the requirements of clause 16 of IEC 60601-

1:2005 (General requirements for basic safety and essential performance). 

If connections are made to standard equipment such as printers and computers, special precautions must be taken in 

order to maintain medical safety. The following notes are provided for guidance in making such connections to ensure 

that the general requirements of clause 16 of IEC 60601-1:2005 are met. 

The following signal inputs and outputs on the Amplivox PC850 audiometer are electrically isolated to the requirements 

of IEC 60601-1 in order to reduce any potential hazard associated with the use of mains-powered equipment connected 

to these inputs and outputs: 

 

Socket Label Socket Type Typical Connection 

USB USB Connector 

Type B 

Computer 

 

External equipment intended for connection to signal input, signal output or other connectors, shall comply with the 

relevant IEC or international standards (e.g. IEC 60950, CISPR 22 & CISPR 24 for IT equipment, and the IEC 60601 series 

for medical electrical equipment). 

Equipment not complying with IEC 60601 shall be kept outside the patient environment, as defined in IEC 60601-

1:2005 (at least 1.5m from the patient). The operator must not touch the connected equipment and the patient at 

the same time as this would result in an unacceptable hazard. 

Refer to Diagrams 1 & 2 below for typical configurations of connected peripheral equipment.  

Refer to Amplivox Ltd at the address given on the front of this user manual if advice is required regarding the use of 

peripheral equipment. 

 

Diagram 1: PC850 used with the medically-approved mains adapter 
 
 
 

Diagram 2: PC850 used with the medically-approved mains adapter and PC 
 
 
 
 
 
 

 

  

Mains outlet Medical Mains Adapter PC850 

Via USB 

Mains outlet Medical Mains Adapter PC850 

Mains outlet PC PC Adapter PC 
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